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Introduction to Computing & Word Processing 
 

The book is designed to enable complete beginners (and improvers) to start using 

a Windows 10 computer and word-processing using Word as part of Office 365.  

It assumes the use of a desktop or laptop computer, but should work on most 

devices that can run Office 365 and Windows. 

 

We understand that students using this book will have different levels of 

experience and will learn at different rates: 

 

 Some of you will have used a computer before.  If you are already familiar 

with the topics covered in the first few pages then start further into the course. 

 

 Some of you will have never used a keyboard.  Some of you will have to 

learn to use a mouse, some of you will be learning how to use a touch screen 

device.  Don’t worry.  It doesn’t matter how slowly you progress through the 

course.  It isn’t a competition. 

 

This course has been designed so that you can work through it at your own pace.   

 

There is ALWAYS more than one way of doing anything and everything on 

a computer.  This course will try to teach you just one way of doing each 

thing.  If you find another way to do something that you prefer, then use 

that way. 

 

If you see someone doing something a different way from the way shown 

here, that doesn’t make them right and this course wrong.  Nor does it make 

this course right and them wrong.  It proves that there really is more than 

one way of doing everything.   

 

Remember – computing is supposed to be FUN 

☺☺☺☺☺ 
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A few Words of Caution 
 
If you are going to spend time using a computer it is well worth making sure that 

you are comfortable and using the computer properly. 

 

 Make sure that your chair is the right height.  If necessary, adjust the back so 

that it provides you with proper support.  If it doesn’t, find another chair. 

 

 If you are using a separate monitor, make sure that it is adjusted so that you 

can look straight at it.  Most will tilt/swivel to make them comfortable to look 

at.  You can easily get neck/shoulder strain if you are having to stoop/stretch 

to look at it. 

 

 If you wear glasses make sure the screen is at a comfortable reading distance.   

 

 Don’t strain your eyes by looking at the screen for too long.  If your eyes start 

to feel tired, take a break.  Go for a walk round – especially worthwhile if you 

suffer from circulation or other problems too. 

 

Videos 
 

 This course is supported by a number of videos.  Links to the 

videos are given throughout the course and are indicated by this 

symbol. 

 Clicking or tapping on the symbol will take you to the video on the IT-

Teacher channel on Youtube (if you are connected to the internet). 

 Some of the videos are openly available on Youtube, some are only visible to 

those who have purchased this course and have the link.   
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The Mouse 
 

Many people still use desktop computers, or laptops with an external mouse 

plugged in. The mouse is a very useful ‘tool’ for working with a computer. 

 

Start by just looking at it.  You will see that it has two buttons (of course, just to 

be awkward, some have three buttons and some have a wheel too, but you can 

ignore those for now, if you have them).   

 

 

 

 

 

 

 

 Place your right hand over the mouse and move it around.  Watch the arrow 

or I point on the screen move as you move the mouse.   

 

 If you are left handed you have 3 options!  Use the mouse with your right 

hand.  Use the mouse with your left hand, with the buttons working as above.  

OR –  change the mouse for left handed use.  In which case the left button 

becomes the right and the right button becomes the left!!  

 

Swapping the Left and Right Mouse Buttons 

 

 To change the mouse (external or keyboard mounted) for left 

handed use: 

 

o Type “Mouse” into the search box at the 

bottom left of your screen. 

 

o You should see “Change your mouse 

settings” appear at the top of the list of 

answers. 

 

o Click or tap on this. 

 
  

 

Right button Left button 

https://youtu.be/et0_hPs8V6Q
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 Click or tap on the 

downward pointing 

arrow beside “Select 

your primary button” 

 

 

 

 

 

 

 

 

 

 

 Left click on “right” (yes, I really do mean that) if you 

want to change the buttons for left handed use.  

 

 Your left and right mouse buttons have swapped function. 

 

 There are three basic actions that you can do with the mouse:  

1. Single click 

2. Double click 

3. Dragging and dropping 

These will be explained in the main body of the course. 

 

 As the course progresses you will get better at using the mouse.  Don’t worry 

if you find it difficult at first.   

 

 One thing to remember when using the mouse.   

 
It’s not where you start that matters, but where you finish! 

 

In other words, if you accidentally move the mouse while clicking on a button – 

the computer will open/close/do whatever the mouse was pointing at when you 

LET GO of the button.  Try not to move the mouse when clicking. 

 

 One of my many mantras when teaching classes is “don’t attack the mouse, 

it hasn’t done you any harm”. 
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 You just need to click the button gently.  If you click too hard you will hold 

the button down and you might find that the computer does something 

completely different from what you wanted it to do.  

 

 Also, pressing the button too hard increases the chances of moving the mouse 

and accidentally clicking on something else.  Be gentle with the mouse – it’s 

just a small furry creature, after all (😊). 
 

 And while I’m talking about mantras – this next one invariably makes 

everyone in my classes laugh – yet everyone does it – and I mean everyone. 
 

o You click on an icon and it doesn’t do what you think/want it to do. 

o What are you going to do?  Click on it again in case it changes its 

mind?  (That’s what most students do.) 

o If it still doesn’t do what you want it to do, what are you going to 

do? 

o Click on it a third time in case it changes its mind?   

o It’s unlikely to change its mind – so better to try clicking on 

something else. 
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Opening an App 
 

There are 3 main ways of opening an app in Windows 10 (told you there was 

always more than one way of doing something!!) 

 

1.  Click on the ‘Windows’ button at the bottom left of 

your screen 

 

 This will bring up a list of your apps. 

 

 An alphabetical list of all the apps on your device 

should appear. 

 

 Scroll down the list, by clicking on the little upward 

or downward pointing arrows, until you find the app 

you want. 

 

 Click the left mouse button once on the app you 

want. 
 

 

 

2. When you first start your device you will be looking at the ‘desktop’ or home 

screen – the opening screen with lots of pictures ‘icons’.  

 

 Look to see if there is an icon for the app you want to 

start. 

 

 If there is, you can double click or tap on the icon to start 

the app.  (Try to click on the PICTURE and NOT on the 

text underneath it.) 
 

 

 

 

 
 

3. Look to see if the app you want has been pinned to the taskbar at the bottom of 

your screen.  If it has, you can tap or click on it there to open it. 
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Single Click or Double Click? 
 

To Single Click or Double Click, That Is The Question? (As Shakespeare 

would have said if they’d invented computers in his time.) 

 

 It’s an often asked question – “how do I know whether to single click/tap or 

double click/tap?”   It’s not hard – try a single click/tap.  If nothing happens 

you have two choices – you can stare malevolently at the computer, or you 

can try double clicking/tapping.  The second is usually more effective. 
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Getting Started 
 
1. Start by opening up Microsoft Word.  Double click or tap on the icon on the 

desktop.  Click or tap on the icon on the taskbar, or Click or tap on the icon in 

your apps list. 

 

2. Look at the sheet on Basic Windows Terms.  (Page 13)  

 

3. We’re now going to try using some of the basic icons you can see on 

your screen so you can see what each of them does. 

 

4. If you are using a mouse, move it so that the mouse cursor 

points to the minus sign at the top right of the screen 

(minimise).   

 

5. Press the left mouse button once only (a single click).  If you are using a 

touch screen device just tap gently on the minus sign. 

 

6. See what happens.  Word should disappear from your screen. 

 

7. Now look on your taskbar at the bottom of the screen.  Is there a 

button with the Microsoft Word icon on it?   
 

8. Move the mouse so the cursor points at this button.  Again, click the left 

mouse button once (or tap) and the app should fill the screen again. 
 

9. Try the restore button.(immediately next to the minimise 

button, top right of the screen).  Now click or tap on it 

again.  Can you see what happens?   
 

10.  Your app should reduce in size so it partially fills the screen.  Click or tap on 

the little square again to make the app fill the screen.  (This is useful to know 

if you open an app and it doesn’t appear full size.  Just click or tap on the 

little square at the top right to make your app fill the screen.) 
 

11.  Now try clicking or tapping on the cross.  This will close down Word.  Can 

you remember how to open it again?  

https://youtu.be/G23o0PaNhz0
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Some Basic Windows Terms 
   

Your document’s name Menu Tabs 

The Ribbon, 

containing 

icons (pictures) 

Task Bar.  

Click on the 

buttons to 

change from 

one app to 

another 

Scrollbars.  When 

you see a scrollbar 

it tells you that 

there is more of 

your document 

somewhere off the 

screen.  Click on 

the arrows to reach 

other parts of your 

document.  

There may be a 

horizontal scroll 

bar at the bottom 

of your screen. 

Minimise – puts your app 

on the taskbar 
 

Restore – enlarges the app to fill 

the screen, or reduces it to fill 

only part of the screen 

Close.  Closes 

the app you are 

working on. 
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The Icons 
 
1. With so many icons (pictures) on the screen when you are using Word, you 

are probably wondering how you will ever remember what they all do. 

 

2. If you are using a mouse there is a useful feature to help you. 

 

3. Move the mouse so that the cursor points to one 

of the icons.  DON’T CLICK THE BUTTON.  

Just wait patiently and you will see that 

Windows will tell you what the icon does:  for 

example, point the mouse cursor at the icon 

marked B.  See the word Bold appear. 

 

4. These screen hints are quite common in many apps and useful if you are 

using a mouse and cursor.   
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Dragging and Dropping 
 
As you become more experienced at using a computer, you will find that 

‘dragging and dropping’ is a useful thing to be able to do.  To give you an idea 

of what we mean by ‘dragging and dropping’, try this: 

 

 Click or tap on the restore button to reduce the size of Word so that it fills 

part of the screen.  (Restore is the middle of the 3 icons, top right of your 

screen.) 

 

 Now – either point the mouse cursor to a 

blank bit of the coloured strip across the 

top of the app. 

 

o Press the left mouse button and 

HOLD IT DOWN. 

 

o Move the mouse.  You will see that the picture on the screen comes 

with you. 

 

o Release the mouse button. 

 

 Or – tap and hold on a blank bit of the coloured strip. 

 

o Move your finger and the window on the screen will move with 

you. 

 

 Click or tap on Restore to enlarge the picture to fill the screen.  
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Introduction to Word Processing 
 
Find some text that you can type in to Word to get you started.  A page from a 

book or magazine will be fine.  Anything that you can practice typing with. 

 

Remember – you don’t have to press the Enter key at the end of each line 

UNLESS you want to start a new paragraph.  The computer will automatically 

wrap the text onto the next line.  Watch the screen to see what the computer 

does. 

 

Basic Text entry 
 

1. Start typing in your text.  

 

o If you have never used a keyboard before you might find this takes 

time.  Don’t worry.  Take as long as you need.   

 

o You might spend your first session entering this text and learning 

where the letters are on the keyboard – that’s ok.  Don’t stress 

yourself. 

 

2. Once you have entered a couple of paragraphs of text, take a look at the sheet 

headed ‘Basic keyboard keys’.  (Page 17) 

 

o Read the sheet and try each key in turn. 
 

o Do take time to look at these keys.  They are vital 
tools that you will need for editing text when you 
are word processing. 

 

3. Read pages 15, 16 and 17 and continue entering your text.   
 

4. TYPING MISTAKES ARE GOOD.  If you don’t make any mistakes when 

entering your text, you can’t learn how to correct them. 

 

5. Try all the suggested icons to see what effect each one has on the text. 
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Basic Keyboard Keys 
 

Once you have entered some text into the computer, you will be able 

to use these keys to help you to navigate around the screen.   

 
 
Enter (         ) 

Use this to force the computer to start a new line of text or a 

new paragraph. 

 Move the typing cursor down or up one line at a time.  This 

ONLY works within the text you have entered (and 

remember – pressing enter or the spacebar to create a blank 

space counts as entering text).  The arrows will NOT move 

the cursor into an area of the screen where you have NOT 

entered text. 

 Move the typing cursor right or left one character at a time 

Home  Moves the cursor to the start of the current line 

End  Moves the cursor to the end of the current line 

Page Up Moves the cursor up the page about ½ screen at a time 

Page Down Moves the cursor down the page about ½ screen at a time 

Ctrl/Home Moves the cursor to the beginning of the first page of a 

document 

Ctrl/End Moves the cursor to the end of the last page of a document 

Delete Deletes forward (to the right) one character at a time 

Backspace (      ) Deletes backwards (to the left) one character at a time 

Shift Hold this down to type a capital (upper case) letter 

Caps Lock Press this key (the Caps Lock light comes on) to type a 

series of capital letters 

 

  

https://youtu.be/wtrjTzcAV-g
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Altering the Appearance of Text 
You can tell the computer how you want your text to look before you start 

typing.  Or - you can change text after it has been typed.  

 
Before you type 
Look at the sheets headed ‘Basic Word-processing Functions’.  (Pages 19 & 

20) These give you an idea of what some of the icons do and how they will 

affect the text you type.  

 

 Have a go.  Click on one of the icons, and then type some text. 

 

 Click on another icon and type some more text. 

 

 Work your way through the basic word-processing functions sheet.  Click on 

an icon and then type a line of text. 

 
Changing Text that has been typed 
 Before you change text that has already been typed, you MUST tell the 

computer WHICH TEXT to change. 

 

 You do this by HIGHLIGHTING the text. 

 

Using a mouse to highlight text 

 

o Point the mouse cursor to the start of the piece of text you want to 

change. 

 

o Press the left mouse button and HOLD IT DOWN.  Don’t let go until 

you have highlighted all the text. 

 

o With the left mouse button held down move the mouse (drag) so that 

the text is highlighted. 

 

o Release the left mouse button. 

 

o Now point the mouse cursor at the icon of your choice and click on it. 

 

 

 

https://youtu.be/WoabEN0c87k
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Using a touch screen to highlight text 

 

• Double tap on any word that is part of the text you want to highlight. 

 

• The word will be highlighted and two little circles will 

appear (or squares, or other symbol depending on which 

device you are using). 

 

• Touch either of these circles with your finger and drag them until they 

cover all the text you want to highlight and change. 

 

 You will need to remove the highlighting to see the full effect of your choice.  

Just point the mouse cursor to a blank bit of your screen and click the left 

mouse button.  Or tap on a blank bit of your screen. 
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Some Basic Word-processing Functions 
 
 Enter some text. 

 

 While you are entering the text try clicking on some of these icons (pictures) 

to see what they do:   

 

o Bold 

 

o Italic 

 

o Underline 

 

 

 

 Try altering the alignment of your text by clicking on these icons: 

 

o Left Align 

 

o Centre 

 

o Right Align 

 

o Justify 

 

 

 Alter the appearance of your text by changing its size and its typeface: 

 

 

o Change size by clicking on down arrow (wherever 

you see a downward pointing arrow like this there 

will be a drop down menu of choices) 

 

o Click on new size 

 

o Change type face in the same way 

 

o Click on down arrow 

 

o Click on new typeface 
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Some other icons to try 
 

 Add bullets 

 

 Move text to the left 

 

 Move text to the right 

 

 

Saving and Printing 
 

Saving your work for the first time 
 

 Click or tap on the “File” tab at the top left of your screen 

and click the left mouse button once. 

 

 A menu of options will appear. 

 

 Choose Save or Save As (it doesn’t matter which you choose if 

you haven’t saved your document before.)  

 

 (In Windows 10 the saving options can be quite confusing, so I’ll 

tell you just one way of saving.  You can experiment with the 

other options if you’d like to.) 

 

 Another menu will appear beside the blue strip, headed “Save 

As”. 

 

 

 

 Click on “Browse” 
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 A dialog box will appear – 

asking you to give your 

document a name and also 

asking you to choose 

where to save it.  

 

 Tap or click in the white 

box, beside the words ‘File 

name’ and type a name for 

your document (Word will 

try to fill this in using the 

first bit of text in your 

document).  

 

 Next, check to see where 

you are saving the 

document so you know where to find it again.  If you want to save it in your 

documents folder, tap or click on the word “Documents” on the left of the 

dialog box. 

 

 Once you are happy with the file name and location, tap or click on Save. 

 

The Difference Between Save and Save As 
 

 

 Don’t worry if this is confusing at first.  You can come back and 

read it again later when you are a bit more familiar with using the computer. 

 As you saw above, the first time you save a document, the Save As dialog 

box will appear and you will be asked to give your document a name and 

choose where to save it. 

 When you open a document that you have previously saved it already has a 

name and a location – so to save your changes you can just choose “Save”.  

The computer won’t ask you to give the document a name, or choose where 

to save is as it already knows both of these. 

 However, there are times when you might want to save your amended 

document to a different location – or save your amended document AND 

keep the original version. 

https://youtu.be/j9soSRObBhQ
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 This is when you use Save As.  For a document that has previously been 

saved, Save As = Save As Something (and/or Somewhere) Different. 

 

 If you want to keep your original document and the amended document, do a 

Save As and give your amended document a different name.  You now have 

two document, with two different names – one is your original and one is the 

amended version 

 If you want to save your document to a different location, but keep the same 

name (for example if you are saving it to a memory stick to take with you), 

do a Save As and choose the location where you want to save your 

document. 

 

Printing your work 
 

 Tap or click on “File” at the top left of your screen.  

 

 This time, choose “Print”.  

 

 A menu of options will appear.  Unless 

you want to print multiple copies or alter 

other settings you can usually just click on 

the square “Print” box. 

 

 Check to see that your printer is displayed 

in the “Printer” box and that it is online – 

mine was offline when I took this 

screenshot. 

 

 The most common reasons for your printer being offline are a) it isn’t turned 

on – which mine wasn’t, b) the printer cable isn’t plugged in or c) if you are 

using a wireless printer either the printer or your device are not connected to 

the network. 
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Shutting Down the Computer 
 

 Click or tap on the Windows button at the bottom left of your 

screen. 

 A menu will pop up.  Look at the bottom left of this menu and 

you will the “Power” button.  Click or tap on this button. 

 You have a choice of actions.  You can: 

o Shut Down the Computer.  This will clear the memory 

and the computer will restart from scratch.   

o Restart the computer.  The computer shuts down, then 

restarts itself.  This is often helpful if your computer is 

behaving badly! 

o Sleep the computer.  The computer goes into a low power state and 

restarts quickly.  This is a tempting option, but the memory does 

not get cleared and every so often you will need to Shut Down the 

computer to reset the memory. 
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Practice What You’ve Learnt So Far 
 

 On the next page is a letter.  Try and enter the text as shown.  This will give 

you extra practice in using the functions listed above. 

 

 I have given you some formatting hints in the grey boxes.  See if you can 

remember how to achieve these. 

 

 If you already have a file open you will 

need to START A NEW BLANK 

DOCUMENT before you can type the 

letter. 
 

 Click or on “File” at the top left of your 

screen and then choose “New” and 

“Black Document”.  
 

 When you are feeling adventurous you 

can try some of the other styles of 

documents listed beside “blank 

document”. 
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18 Hanley Court 

New Street 

Ledbury 

Herefordshire 

HR8 1AA 
 

Wilson Brothers Plumbing 

78 Gloucester Drive 

Newent 

Gloucestershire 
 

12 July 2017 
 

 

Dear Mr Wilson 

 

Re:  New Kitchen at 18 Hanley Court 
 

Thank you for the kitchen brochures.  We have decided to have the Arctic Summer 

range from the “21st Century Kitchens” brochure. We like all the tiles that you 

showed us, so are happy to let you use whichever you are able to source easily.  

We do not want anything in pink or green..  Our preferred colours would be white 

or beige. 

 

As discussed, we hope that you will be able to complete the work before the end 

of September.   

 

1. Please make sure that the gap between the long work surface and the full 

height cupboard is wide enough to fit our existing fridge freezer  

2. We would like you to supply a mixer tap for the sink  

3. Please arrange for an electrician to carry out the electrical work on the 

new cooker and cooker hood 

 

Yours Sincerely 

 

  

 Right Aligned 

 Different typeface (try Comic Sans) 

 Size 16 

 Left aligned 

 Times New Roman 

 Size 14 

Bold & Underlined 

Italic Bold 

Numbered 

paragraphs 
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Undo (or – Help, I Didn’t Mean to do That) 
 
The mouse is a very useful tool, but sadly doesn’t have a brain.  It is very easy to 

do something that you didn’t intend to do.  Perhaps because you clicked a button 

when you didn’t mean to, or moved the mouse when you didn’t mean to. 

 

If you have a touch screen device it is just as easy to touch the screen 

accidentally and your device will do whatever it is you just told it to do! 

 

This is when you need Your Best Friend on the computer – ‘UNDO’.   

 

You can ‘undo' almost anything. 

 

 The easiest way to ‘undo’ is to use the ‘undo’ icon.               

 

 Point the mouse at this icon and you will see the 

words ‘undo ****’ appear.  (Do you remember on page 13 that I told you 

that you can point your mouse at an icon and if you wait for a second or two 

a helpful screen hint will appear telling you what the icon does.  This only 

applies if you are using a mouse.) 

 

 Click or tap and you will see that the computer will ‘undo’ whatever you last 

did.  Magic.  

 

 So – next time you highlight the whole of your letter when you only meant to 

highlight one line, or all your work disappears because you pressed ‘delete’ 

by mistake, don’t panic – point the mouse cursor at the ‘undo’ icon and click 

on it.  

 

 (Once you have undone something, you can then redo it using the redo icon.) 
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Margins 
 

 

Use the letter you have just typed to practice altering 

the margins. 

 

 Click on the “Layout” tab at the top of your 

screen.  

 

 Click on ‘Margins’. 

 

 You can choose from a range of preset options or 

set your own margins using “Custom Margins” – 

For custom margins, click on text BELOW the 

icon. 

 

 This will bring up the Page Setup dialog box.  

Make sure that the “Margins” tab is selected. 

 

 You can change the margins in 2 ways: 

 

o Click in a box to type a number directly, or 

o Use the up and down arrows to change the numbers. 
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Finishing your Work 
 

 When you have finished the letter, save it and then print it out.  Refer to page 

20 on saving and printing if you need to. 

 

 Close the file by clicking on the cross at the top right of your screen. 
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Starting a New Document/Opening an Existing Document 
 

Sometimes when you start working you will want to start a new document.  

Sometimes you will want to work on an existing document. 

 

Starting a New Blank Document 
 

 

 When you first open Word you will get a 

new blank document. 

 

 If you have been working on an existing 

file, you might then want to start a new 

document. 
 

 Click or on “File” at the top left of your 

screen and then choose “New” and 

“Black Document”.  
 

 

 
Opening an Existing Document 
 
 Click on File at the top left of your screen and then choose ‘Open’. 

 

 Select the file you want from the list, if it appears in your recent documents 

(click on it once). 

 

 If the document you want to open isn’t listed in recent 

documents, click on “Browse” to locate it 

on your computer.  

 

 Once you’ve found the document you 

want, double click or double tap on it to 

open it, or select it (single click or tap) 

and then click or tap on “Open”.  

 

 (Note, that you can also open a document by choosing from the list in your 

documents folder.  Double clicking or tapping on it will open the document.) 
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Cut, Copy & Paste 
 

 Before you start this exercise, if you have any files already open, 

CLOSE them. 
 Start a NEW file (see page 29 above for how to do this). 
 

Highlighting Text 
 

Before we start, some words of wisdom for those of you using a mouse. 

 

 When you are highlighting text you CANNOT start in the middle of your 

selection – you have to start at one end or the other.  You cannot drag the 

mouse both ways  (this doesn’t apply if you are using a touch screen, only if 

you are using a mouse.) 

 

 Point your mouse to the start of the word or words you want to highlight, 

press the left mouse button, hold it down and drag the mouse across the text.  

DO NOT let go of the mouse button until your text is highlighted. 

 

 If you accidentally let go before your text is properly highlighted, DO NOT 

try to correct your mistake.  Move the mouse so the cursor points at a blank 

bit of the screen and click the left mouse button to remove the highlighting – 

then try again. 

 

What Cut, Copy and Paste do 
 
CUT – cuts out (or removes) your chosen text/graphic.  

It is stored in a special area of the computer’s memory 

called the clipboard, ready for you to paste it 

somewhere else.   

 

COPY – leaves your chosen text/graphic in its original 

place and places a copy of it on the clipboard, ready for 

you to paste somewhere else. 

 

PASTE – pastes the contents of the clipboard into the chosen place in your 

document.      
 

https://youtu.be/mhaAq0snnKE
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Have a go 
 

First of all you need to type in some text.  Imagine that you are going shopping 

in the supermarket and type in your shopping list.   

 

Cut & Paste 
 Here’s my list. 

 

 We are going to adjust the list so that it is in the order you 

would find things as you go round the 

shop: 

 

 If you look at the cut/copy/paste icons 

now you will probably see that they are 

‘greyed out’ – like this:  

 

 This is because you haven’t yet told 

the computer what you want it to cut or copy. 

 

 ‘Oranges’ need to come after ‘apples’.  Highlight the word oranges.  If you 

are using a mouse, press the left mouse button, hold it down and drag the 

mouse cursor across the word oranges.  If you are using a 

touch screen, double tap on the word “oranges” – then use the 

little handles to expand the selection if you want to highlight 

more text.  

 

 Release the mouse button or remove your finger from 

the screen, then tap or click on the cut icon.  

 

 Move the typing cursor to the beginning of the word ‘carrots’.  You can do 

this using the arrow keys on your keyboard, or you can tap or click 

immediately before the “c” of carrots.  This tells your device where you 

want to paste the text that you have just cut. 

 

  Now tap or click on the ‘paste’ icon.  

 

 Hey presto, oranges now comes after apples. 

 

Apples 

oranges 

carrots 

eggs 

fruit juice 

peas 

butter  

tinned beans 

tissues 

tinned soup 
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 BUT – I hear you all cry – I’ve got a space in my list and/or oranges now 

joins onto carrots! 

 

 You will have to play around adjusting the spacing.  When you first typed 

the list you pressed the enter key at the end of each line.  You can’t see the 

‘enter’ character, but the computer knows it is there.  What happens when 

you cut/copy and then paste depends on whether or not you highlighted one 

of these enter characters.   

 

 Don’t worry about it, just adjust the list so it looks right. 

 

For example – here we need to send oranges onto a 

new line.  Move the cursor to just before the “o” of 

oranges and then press the enter key on your keyboard.  

(If you don’t know which key this is, take a look at the 

“Basic Keyboard Keys” on page 16 above). 

 

We also need to REMOVE the space between “tinned 

beans” and “soup”.  Move the cursor to the space 

BETWEEN the two items and press delete on your 

keyboard. 

 

One of my mantras when I’m teaching classes is that “if you have blank space 

you don’t want you need to DELETE it”.  You DO NOT want to “move” the 

items that are further down the list, you want to DELETE the space between 

“tinned beans” and “soup”. 

 

 Continue highlighting text, cutting and then pasting until the list looks right. 

 

Copy & Paste 
 

 You realise that you want to buy tinned peas and tinned soup. 

 

 Highlight the word ‘tinned’ and then use the mouse to click on the ‘copy’ 

icon. 

 

 Move the cursor to the start of the word ‘peas’ and then click on the paste 

icon. (You may need to insert the space between tinned and peas.)  Do the 

same to make ‘tinned soup’. 

 

Now Save your work and Print it.  

Apples oranges 

carrots  

peas 

tinned beans  

 

soup 

eggs  

butter 

fruit juice  

tissues 
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The Clipboard 
 
This is a special part of your computer’s memory which ‘remembers’ what you 

have just cut or copied.  Once you have cut or copied something to the clipboard 

it will stay there until you cut or copy something else.  This means that you can: 

 

a) paste something in as many times as you like. 

 

b) paste something from one document to another, or even from one app to 

another. (For example, you may have a picture/photo in an e-mail.  You 

can ‘copy’ it from the e-mail – go into your word processor and ‘paste’ it 

into your document.) 

 

More ways of copying/cutting and pasting 
 

 You can use ‘keyboard shortcuts’.  Highlight your chosen text and then 

press: 

 Ctrl + C to copy 

 Ctrl + X to cut 

 Ctrl + V to paste 

 

 You can use the mouse to RIGHT click on the highlighted text. Then choose 

cut, copy or paste from the list.  
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Adding Colour 
 
Why not add some colour to your shopping list? 

 

 Highlight one of the words on the list (press the left 

mouse button, hold it down and drag the cursor 

across the word). 

 

 Click on the little DOWN ARROW beside the A at 

the top of your screen. 

 

 Choose a colour from the drop down menu that 

appears. 

 

 

Page Orientation 
 

 Everything that you have produced so far has used the page in 

Portrait mode.  The page looks like this: 

 

 Sometimes it is useful to turn the page round and produce 

your work in Landscape mode.  The page looks like this: 

 

 To change the layout of the page click 

on the Layout tab and then choose 

Orientation. 

 

 Click on Landscape.  
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Spelling and Grammar Checkers 
 
By now you will have noticed that there are times when the computer puts red 

lines or blue lines under your text. 

 

Blue lines 
 

The double blue lines are the automatic grammar checker.  You’ll see this most 

often if you leave two spaces between a word instead of one, for example.  This 

can be quite useful, but remember that it is probably an American grammar 

checker. 

 

If you are using an older version of Word, you might see squiggly green lines 

instead of double blue lines. 

 

Red Lines 
 

 The red wiggly lines are words that the computer does not recognise.  (The 

list of words it recognises is probably American.) 

 

 This is an occasion when the RIGHT button on your mouse is useful. 

 

 Position the mouse cursor over the word the computer doesn’t recognise. 

 

 Click the RIGHT mouse button or tap 

on the word. 

 

 The computer might give you a list of 

alternative suggestions.  If the correct 

word is on the list, use the LEFT 

mouse button to click on it, or tap on it. 

 

 The word might be correct (perhaps because it is a person’s name, or a place 

name).  

o Clicking on Ignore All means the computer will simply ignore the 

word anywhere that it appears in the document you are working on. 

 

o Clicking on Add will add the word to the computer’s dictionary and 

will ignore it in all future documents.  (Useful if the word forms 

part of your address, or is a name you write to regularly.)  
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Just for Fun 
 

The Spelling checker is a useful tool, but has its limitations.  There is no 

substitute for reading your work through! 

 

The (Curse of the) Spell Chequer 

 

Eye have a spelling chequer 

It came with my pea sea 

It plainly marques four my revue 

Miss steaks eye kin knot sea. 

 

Eye strike a quay and type a word 

And weight four it two say 

Weather eye am wrong oar rite 

It shows me straight a weigh 

 

As soon as a mist ache is maid 

It nose be four two long 

And eye can putt the error rite 

Its rear lea ever wrong 

 

Eye have run this poem threw it 

I am shoe your please two no 

It letter perfect awl the weigh 

My chequer tolled me sew. 
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Using WordArt 
 
Word Art is a fun way of making your posters, adverts, cards, 

letters, invitations etc look eye catching and interesting.  It really 

isn’t difficult.   

 
 Click or tap on the Insert tab and then choose WordArt. 

 

 

 This will open the WordArt Gallery. 

 

 Click on the style you fancy (you can 

change it later).   

 

 

 

 

 

 

 

 When you get the message ‘Your Text Here’ – enter some text! 

 

 Try entering your name, or ‘Happy Birthday’, or whatever you fancy. 

 

  

https://youtu.be/mhaAq0snnKE
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 Notice that a new tab has been added to your ribbon – “Format”.   

 

 Also notice the little grey circles that surround your text.   

 

 You will then be able to move your WordArt around the page by ‘dragging 

and dropping’. (We did this on page 14.) 

 

 Mouse Users 

o Point the mouse at the box your text is in and notice that the cursor 

changes to a four headed arrow:   

 

o When the cursor looks like this you can ‘drag and drop’ your 

WordArt to anywhere on the page by pressing the left mouse button 

– HOLDING IT DOWN – and moving the mouse until your text is 

where you want it to be.  

 Touch screen users  

o Touch the screen anywhere in the WordArt box and move your 

finger across the screen. 

 

 When your text is where you want it, release the left mouse button or remove 

your finger from the screen. 

 

 
 

 Try experimenting with some of the icons on the WordArt part of the Format 

tab on the ribbon. 

 

 Look at the screen.  Beside most of those icons you can see a downward 

pointing arrow.  A downward pointing arrow ALWAYS means there is a 

drop down menu of choices.   

 

 (NOTE:  If the WordArt tools disappear or the circles disappear, click or tap 

on your WordArt text to get back the ‘handles’ and the tools.) 

 

 Click or tap on your WordArt text to change it.  
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 Choose ‘WordArt Styles’ to change the style of your WordArt.  Click on the 

little up or down pointing arrows at the right hand side of the styles to show 

further options. 

 

 Choose Shape Fill or Shape 

Outline to change the colours. 

 

 Choose ‘Change Shape’ to change 

the shape of your Art. 

 

 The best way to learn how to use WordArt is to experiment.  The computer 

doesn’t mind if you get it wrong, just delete your WordArt and try again. 

 

 If I try to tell you each individual option you would die of boredom part way 

through. 

 

 So, go on, get stuck and have a play.   

 

 Experiment with the remaining icons to see what they do. 

 

 If you decide you don’t like your Art – you can delete it.  Make sure that its 

‘handles’ are displayed and press the ‘delete’ key. 
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Design a Poster 
 

This will give you an opportunity to practice what you have learnt, and teach 

you some new features of Word. 

 

 Use Landscape Mode 

 

 Set the margins to: 1.8 cm for the top and bottom 

 

2.4 cm for the left and right 

 

 Use different font sizes 

 

 Use different font styles  

 

 Use bold/italic/underline 

 

 Use the alignment icons 

 

 Use WordArt for the heading 

 

 

Your poster might look something like the one below: 
 

 When you are happy with your poster 

o  save it 

o  print it 

o  and close it 
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You can make your poster more interesting by using borders and shading and 

adding some pictures or shapes.   

 

 Before using borders and shading on your poster, open a new, blank 

document and try the following exercise: 

 

Borders and Shading 
 

 Type in a heading followed by some text, for example: 

 

 Make sure your flashing typing cursor is positioned in the row that you want 

to put the border round – in this case the heading (use the mouse or the arrow 

keys to move the cursor). 

 

Recipe for Mincemeat 

 

1lb currants 

1lb raisins 

1lb sultanas 

1lb apples 
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 Click on the little down arrow beside 

the borders icon (on the home tab). 

 

 A list of border options will appear. 

 

 

 

 

 

 Try experimenting with the different borders and 

shadings. 

 

 Notice that at the bottom of the list of border styles 

there is an option for “Borders and Shading”.   

 

 This will bring up a dialog box with 

lots of options for you to try – 

including the option to place a border 

around the outside of the whole page.  

 

 When you have had some practice, 

save your work and close it. 
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Improving the Poster 
 

 Open the poster you designed earlier.  Add some borders to it.   

 

 Your work might look something like the one below. 

 

 

 
  



 It’s Never Too Late To Learn IT# 

 

© Carol Smith 2017 45 www.it-teacher.co.uk  

Adding Pictures 
 

 You are going to add a picture to your poster using 

a photo you have saved or an online picture. 

 

 We’ll start with “Online Pictures” – note that your 

device needs to be connected to the internet for 

this option. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 An Online Pictures dialog box will appear where you can choose a category 

(note the scroll bar on the right which means you can scroll down for more 

categories).  We are going to search for coffee – our poster is for a coffee 

morning.  (Don’t forget to click on the little magnifying glass symbol beside 

the search box.) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note the warnings about copyright.  You CANNOT just use any picture you find 

on the internet for your own purposes.  Many of them are copyrighted to the 
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owner.  You wouldn’t be happy if you found your photos/pictures being used by 

someone else. 

 

I always think it is safer to use your own photos or pictures if you are in doubt, or 

if you are going to be selling or distributing your work. 

 

 When you have found a picture that you like, click on it to select it and then 

click on “Insert”. 

 

Resizing/Moving your Picture 
 

 The picture that you just inserted might be much too big (or small) for your 

poster.  

 

 Mine is too big.  

 

 Look at your picture, you should see little circles 

(handles) around it. 

 

 To resize your picture using a mouse, point the 

mouse cursor at one of these handles until it 

changes into a double headed arrow. 

 

o Click the left mouse button, hold it down and ‘drag’ the handle to resize 

the picture 

o The middle handles will stretch/shrink the picture in one direction 

o The corner handles will stretch/shrink the picture in two directions at 

once 

 To resize your picture using a touch screen. Tap and hold on one of the 

handles and then drag your finger across the screen.  See above for a 

description of what each of the handles will do. 

 

 If you lose your handles at any time, simply click on the picture to select and 

display the handles. 

 

 To move your picture: 

 

o You will probably need to start by changing the “Wrap text” property of 

your picture so that you can place it exactly where you want it. 

 

o Make sure the picture is selected (its handles are displayed). 
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o Look for “Wrap text” on the Format ribbon, click on the downward 

pointing arrow and then select “Square”.  (You can experiment with the 

other properties too). 

 

 

o Point the mouse cursor at the border of the picture (keep AWAY from 

the circles which resize your picture, they don’t move it) until the 

cursor changes into a four headed arrow.  Or tap and hold somewhere 

on the picture (again, keep AWAY from the circles). 

 

o You can now drag and drop the picture.  
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 When you are happy with your poster, save it, print it and close it.   

 

 This is what mine looks like after some adjusting and moving the picture 

around. 
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Designing a Leaflet 
 

 In this section you are going to design a 3 column leaflet in MS Word. This 

will give you the chance to learn some additional techniques: 

o Columns,  

o page/column breaks,  

o using Find & Replace 

 

 Many of the techniques you have been learning in this course can be used 

across a range of software apps – don’t be afraid to try them! 

 

Setting up Your Leaflet 
 

 Set your page orientation to Landscape 

(see page 34). 

 

Columns 
 

 Make sure the Layout tab is selected. 
 
 Click on the columns icon. 
 

 Select the number of columns you need. 

(Three for a leaflet with 2 folds, 2 if you are designing a leaflet with a single 

fold.) 
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Margins and Column spacing 
 

 For a 3 column leaflet to fold properly you need TWICE as much spacing 

BETWEEN the columns as you do for the left and right hand margins. 

(honestly!) 

 

 So - you need to set up the margins and the spaces between the columns: 

 

o Set the left and right hand margins (Layout/Margins/Custom 

Margins) to 1.5 cm . 

 

o Set the top and bottom margins to 2.5 cm. 

 

 Set up the spaces between the margins: 

 

o Select the “More Columns” option from the 

columns menu. 

 

 

 

 

o In the dialog box that 

appears, set the spacing to 

3cm between columns. 

 

o (Remember, you need 

twice as much space 

between the columns.  So 

left and right margins are 

now 1.5cm and space 

between columns is 3cm). 
 

o Make Sure you select ‘Equal Column Width". 
 
o Click on OK. 
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Designing your Leaflet 
 

 As an example, I’ve reproduced the leaflet for a community 

centre that I designed a few years ago – but I’m sure you can 

think of something much more interesting to put in your leaflet! 

 

 Start by designing the INSIDE of your leaflet. 

 

 As you type, the text will automatically flow from one column into the next 

column.  However – you can force the computer to start a new column by:  

 

Inserting a column break 
 

 Select the Page Layout tab and then click on Breaks. 

 

 In the drop down menu that appears choose Column.  

 

 Any text you type now will appear in the next 

column. 

 

 Use borders and shading for headings.  Use pictures 

or WordArt, different typefaces and type sizes and 

https://youtu.be/Ui0SLaTRnd8
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any other technique you fancy to make your leaflet look interesting. 

 

 When you reach the bottom of the third column you can start a new page by: 

 

Inserting a Page Break 
 

 We’ve said this before – there is always more than one 

way of doing something on a computer. 

 

o You may have noticed when you inserted the 

Column Break that there was also an option 

for inserting a page break.  You can insert 

your page break this way, OR 

 

 You can simply hold down the Control key (Ctrl) on 

the keyboard and press the Enter key.  Magic – a page 

break is automatically inserted.  
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 On the new page you’ve just started you can design the OUTSIDE page of 

your leaflet.   
o A word of Caution!!!!! – REMEMBER – the right hand column 

will form the FRONT of your leaflet. 
 Like this: 

 

 
 When you are happy with your work Save it (File/Save) and Print it 

(File/Print). 

 

Find and Replace 
 

 This can be very useful if you have a longer document and want 

to find a specific word or phrase. 

 

 You can use this function just to find the word or phrase – 

handy if it’s on page 53 of a long document – no need to read through the 

entire document to find the what you are looking for. 

 

 You can use this function to replace text.  Useful if, for example, you need to 

replace the phrase “green striped blanket” with the phrase “blue checked 

throw” and it appears several times in your text. 

 

https://youtu.be/5bWHCbcz744
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 Select the Home tab and look at the top right for the Editing tools.  

 

 Click or tap on Replace. 

 

 In the dialog box that appears, enter the text you want to find. 
 

  

 

 

Enter the text you want to replace it with. 

o Click or tap on Find Next, 

o The computer will display the next occurrence of your chosen text.   

 

 If you want to replace it, click or tap on Replace, otherwise click on Find 

Next. 

 

A Word of Caution! 

 Notice that there is a ‘Replace All’ option.   

 

 This can be DANGEROUS.  For example:   

o You ask the computer to find the word ‘cut’ and replace it with 

‘slice’. 

o You click on ‘Replace All’. 

o Your text originally contained the word – scuttle. 

o It now contains the word ‘sslicetle’ – er what????  

 

 If you are feeling adventurous, click on the ‘More’ button and try some of the 

options displayed. 

 

 Try the ‘Sounds Like’ option – it’s quite clever.  
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Headers and Footers 
 

If you look at the top and bottom of the pages of many documents, especially 

longer ones, you will see that they have common headers and footers.  Like this 

footer: 

 

This one contains some text and, in the middle, a page number.  How do they 

get there? 

 Select the Insert tab on the ribbon and look for the Header and Footer tools. 

 

 Notice that they all have downward pointing arrows, so each icon has a drop 

down list of choices. 

 We’ll look at the footer options. 

 Notice that there are different styles you can 

chose.   

 Click on the one you want to use (Try them 

all) – see what they do. 

 Your footer will be inserted and you will see 

a Header and Footer Design tab has been 

added to your ribbon: 
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 Experiment with the different options – and when you have finished click on 

Close Header and Footer. 

Page Numbers 
 

Notice that there is also a “page number” option.  

 Use this to insert a page number in your header or 

footer.   

 You only need to do this once and the page number 

will change on each page. 

 Tap or click on the arrow and you will see a range of options – you can add it 

to the header section, footer section or to one of the side margins. 

 Again, experiment with the options. 

 If you want to add text to your header/footer as well as a page number, this is 

the place to do it.  Add your page number and then use the keyboard to type 

your text.  (Note, that it doesn’t work the other way round. You can’t insert a 

footer/header, type some text and then insert a page number.  Try it if you 

don’t believe me – I’m always ready to be proved wrong – and each update 

to Word changes things.) 

Editing your Header/Footer 
 

 If you want to go back into your footer (or header) to edit it – just double 

click/tap anywhere in the header/footer – you will then be able to edit the 

content. 
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Managing Your Files and Folders 
 

Right Clicking – Or Tap & Hold 
 

First – I’ll introduce you to a useful little skill – the Right Click (if you are using 

a mouse), the Tap and Hold (if you are using a touch screen). 

 

I don’t tell my students about right clicking too early in a course because the 

instant I tell people about right clicking, every single person in the class will 

ALWAYS ask “which button do I press” when told to click on an icon. 

 

But in this section right clicking is useful.  To save you asking “which button do 

I press” you should ALWAYS use the left unless specifically told to right click. 

 

What does right clicking (or tapping and holding) do?  It brings up a menu of 

choices.  

 

It doesn’t usually tell the computer to do anything – it just brings up a menu. Try 

it – you can right click, or tap and hold on many things on a computer.   

 

As an example, here’s what happened when I 

right clicked on one of the words in the 

previous paragraph.   It brought up a menu of 

choices.  If you want the computer to perform 

any of the actions in the menu, tap or click on 

it.  (Did you ask “which button do I press”? – 

It’s ALWAYS a left click unless specifically 

told to right click.) 

 

If you accidentally tap and hold, or right click, 

and get a menu that you don’t want – tap a 

blank bit of the screen, or move the mouse to a 

blank bit of the screen and click.  If instead, you 

tap or click on any of the options in the menu 

the computer will do whatever you just told it to 

do. 
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File Explorer 
 

 To view the files and folders on a Windows computer you use an app called 

“File Explorer”. 
 

 I see many computers where people have saved hundreds of files 

(documents, pictures, etc) directly into the Documents folder.  They have no 

sub-folders and it becomes increasingly difficult to find anything. 
 

 Many more save everything to their desktop in the vain hope that they’ll find 

them again. 
 

 Using File Explorer you can create new folders to keep your files organised, 

delete unwanted folders and files, rename folders and files, move files to a 

new folder, much more. 
 

The File Explorer Screen 
 

 Launch File Explorer by clicking or tapping on the yellow folder icon in the 

task bar at the bottom of your screen.  
 

 
 

 

 Once you have opened File Explorer, the screen that appears should look 

something like this picture.

 
 

 Note that the screen is divided into two. 
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 The left hand side of the screen displays the filing structure of your 

computer. 
 

 The right hand side of the screen displays the contents of the current ‘folder’. 
 

o Folders are indicated by this symbol. 

 

o Folders may contain sub folders or files. 
 

o Files are indicated by a symbol something like this. 
 

▪ Note – this icon indicates a document created by Word.  Other 

apps use different icons. 
 

 Look at the left hand side and you should be able to see that the filing 

structure is hierarchical (like a family tree – or like a filing cabinet). 
 

 Notice the right facing arrows beside some folders.  

o Folders with an arrow beside them contain sub-folders 

AND files. 

o Folders with no arrow contain ONLY files. 

o Click on the arrow to display the sub-folders. 

 Once you have expanded the list to display sub-folders, the 

higher level folder will have a downward pointing arrow. 

 

o Click on this arrow again to close the folder. 

 

 You can use File Explorer to: 

o Move documents (or folders) from one folder to another. 

o Create new folders. 

o Rename existing folders or documents. 

o Delete unwanted files or folders. 
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The Ribbon 
 

Does the folder menu at the top of File Explorer look like this? 

 

 
 

Or does it look like this? 

 

 
 

 This is why I told you about right clicking (tapping and holding). 

 

 If your ribbon isn’t displayed it can be confusing so point your mouse to the 

BLANK white space to the right of the 

word “view”.  

 

 RIGHT click, or tap and hold.  Remember this should bring up a menu. 

 

 

 

 

 

 

 Click or tap to remove the tick beside “Minimise the Ribbon” (and I hope 

you didn’t ask “which button do I press?” – but I bet you did!!) 
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The “Home” tab 
 

For all the functions I’m going to show you below you will use the “Home” tab 

on the ribbon.  As always there is more than one way of performing each of the 

functions – I will just show you one way. 

 

So, let’s take a look at the Home ribbon. 

 

 
 

 Notice that it has options for Move to and Copy to – useful if you want to 

move a file from one folder to another or place a copy of a file in a different 

folder. 

 

 You can delete a file or folder. 

 

 You can rename a file or folder. 

 

 You can start a New folder. 

 

 Let’s take a closer look at these: 

 

Creating a New Folder 
 

 Click or tap on the New Folder icon.  

 

 Make sure that use choose the correct 

location for your new folder – in this 

example a new folder will be added in 

“Documents”. 

 

 If you want your new folder to be a sub 

folder, make sure you choose the 

folder you want to go in – like this.  

The new folder will become a sub-

folder of “auction”. 
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 Insert your new folder by clicking on the New folder 

icon. 

 

 Notice that the text is highlighted.  If you DON’T 

click/tap you can type the name for your new folder.  

Any text that has been highlighted will be deleted. 

 

 If you make the mistake of clicking or tapping then you will have to delete 

the text that is already there before typing the name. 

 

 If you click away from the new folder before naming it, and it finishes up 

being called New Folder – don’t panic – there is a rename option that you 

can use. 

 

Renaming a Folder (or File) 
 

 To rename a file or folder, first single click/tap 

on the file or folder to select it. 

 

 Then click or tap on the “Rename” icon.  

 

 While the text is highlighted, just type the new 

name. 

 

 As before, if you click in the box and remove 

the highlighting you will have to delete the existing text first. 

 

 NOTE – you cannot rename a folder or document that is open (in Word, 

or any other app).  You will need to close it first. 

 

Deleting a File or Folder 
 Single tap or click on the folder or document you 

want to delete. 

 

 Click or tap on the delete icon. 

 

 Don’t panic if you accidentally delete something – it will 

almost certainly be in the Recycle Bin on your desktop. 
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 Just double click/tap on the Recycle Bin, locate the item 

you want to restore, single click to select it and then 

click on “Restore the selected items”. 

 

 

 

 

 

 

 

Deleting Copying or Moving More Than One File 
 

 If you need to delete, copy or move more than one file, you can do so in one 

simple operation, rather than deleting or moving each one individually. 
 

 To select ALL of the files in a CONSECUTIVE list: 

 

o Click on the first file in the list. 

o HOLD DOWN THE SHIFT KEY. 

o Click on the last file in the list. 

o The WHOLE list will be highlighted. 
 

 Like this:  

 

 

 

 To move a SELECTION of files that are NOT consecutive. 
 

o Click on the first file.  

o HOLD DOWN THE CTRL KEY. 

o Click on each file to be moved. 

o The CHOSEN files will be highlighted. 
 

 Like this:  
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Moving or Copying Files or Folders 
 

 Navigate to the file/folder you want to move.   

 

 Before you can move a file or folder you need to select it by single 

clicking/tapping on it.  

 

 Then click on “Move To” (or Copy To if you want to leave the original 

where it is and place a copy somewhere else as well). 

 

 A menu of recently used folders will appear.  If the place 

you want to move your selected item to isn’t shown, click 

on “choose location” at the bottom of the list. 

 

 This will bring up a dialog box where you can choose the 

location where you want to move/copy to. 

 

 

 

 

 

 

 

 

 

 

 

 

 Navigate to the folder you want to move your file/sub folder to – like this: 

 

.   
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 HELP – I clicked on the wrong thing and I don’t 

know where I’ve moved my document/folder to.  

How am I going to find it????  (in this case, it’s 

called booties, and it’s gone.) 

 

 

 DON’T PANIC.  Take a deep breath.   

 

 RIGHT CLICK on a blank bit of the menu you 

are in. 
 

 Remember – right clicking brings up a menu of 

choices.  

 

 

 

 

 

 

 Click on “Undo Move”. 

 

 Phew – your file/folder is back where it came from. 

 

 

 

 

 

 

 
Finding a File Or Folder 
 If you have lost the file and have no idea where you saved it, there is a useful 

search function. 

 

 Select “Documents” (if that’s where you think the file is), or “Pictures” (if 

that’s where you think it is) from the menu on the left by clicking or tapping 

on it. 

 

 Type the name of your missing file into the Search box and wait while the 

computer searches for that elusive file. 
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 If it still doesn’t find the file, select “This PC” and then redo the search.  The 

computer will look everywhere for your missing file. 
 

 
 

 

 

Opening a file that you have moved/renamed 
 

 If you use the “Recent” documents 

list from the File menu in Word 

AND…. 

 

 

 

 

 
 

 …if you have moved a document 

from one folder to another, or 

renamed it, you will NOT be able 

to open it with this method!   
 

 This is because the computer no longer knows where to look for the file from 

this list – the list simply remembers the last documents you used and where 

they were/what they were called when you used them. 
 

 You will have to use File/Open/Browse to locate the 

moved or renamed file. 
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Backups 
 

My “favourite” subject and one that I can, and do, wax long and 

lyrical about.  

Anyone that has been on one of my courses, and anyone that has 

been a client of mine knows that I am paranoid about backups. 

 

I’ve lost count of the number of clients/students that have learned the hard way 

that your computer can crash, die, get flooded or be stolen – taking all your 

documents, pictures, videos etc with it. 

 

Don’t get caught out. 

DO YOUR BACKUPS. 

How you do this depends on how often you use your computer, how important 

the files it contains are and how many files you have. 

 

Method 1 – Online Backup 

Which, to be awkward, comes in two versions. 

Automatic Backup 

I use an automatic online backup service – it automatically backs up any new or 

changed files without me having to think about doing a backup. 

This kind of online backup service aims to mirror the files on your computer.  If 

you delete a file from your computer it will be deleted from your online backup 

after a certain number of days.  30 days for the service I use. 

The advantage is that backing up happens automatically.  The disadvantage is 

that files deleted from your computer will eventually be deleted from the backup 

as well. 

Manual Online Backup 

There are lots of services that offer online, cloud storage – Dropbox being an 

example.   

Usually, with these services you have to manually add your files.  The 

disadvantage is that backing up doesn’t happen automatically.   

https://youtu.be/f-Zs9IM2P7U
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The advantage is that a file will stay on your backup unless/until you delete it 

from the backup service (it won’t be removed after a specific number of days if 

you delete the file from your computer.)   

Method 2 - Offline Backups 
 

The most common ways of doing this are using either an external hard drive or a 

memory stick. 

This is probably the best way to backup your files if you don’t have very much 

data. 

REMEMBER – a backup means having at least 2 copies of your files.  One on 

your computer and one on the backup medium. 

 

If you REMOVE the files from your computer after coping them to a memory 

stick or external hard drive then you DO NOT have a backup. 

 

If you want to remove data from your computer then you should copy it to 2 

other locations – a memory stick and an online service, a memory stick and a 

hard drive, for example. 

Trust me – computers can break, memory sticks can be lost, external hard drives 

can fail.  You need at least 2 copies of all your data (I have 3). 
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IT Teacher’s Mantras 
 

I’ve often threatened to print these out, laminate them and hang them on the 

walls for my classes. 

 

“Remember – computing is meant to be fun” 

If you start to get frustrated – turn off the computer, walk away and do 

something completely different.  The computer has more patience than you do.  

Shouting at it or calling it all the rudest names you can think of won’t make it 

behave any differently. 

 

I threatened many classes with the introduction of a Swear Box.  It’s amazing 

how a student’s language can deteriorate! 

 

“You’ve activated the people sensor” 

I can’t tell you how many students have looked at me in wide eyed amazement 

because they believe me.  After I’ve recovered from my laughing fit, they 

usually realise they’ve been “had”. 

 

This goes with the mantra above – “computing is meant to be fun”.  People get 

frustrated with the computer and start random clicking, or continue doing 

something that they know isn’t working.  In their frustration they blame the 

computer. 

 

I tell them that computers are fitted with the same people sensors as 

photocopiers. 

 

“Don’t attack the mouse, it hasn’t done you any harm” 

Your mouse is innocent.  Honestly.  It hasn’t done you any harm. 

 

If it all goes horribly wrong it’s usually because you accidentally clicked (or 

tapped) on something you didn’t mean to.  The harder you click the mouse 

button, or press on the screen, the more chance there is of something happening 

that you don’t understand or didn’t intend. 

 

Click the mouse button gently – that way you are less likely to move the mouse 

and reduce the chances of clicking on something you didn’t mean to click on. 

 

“If you have blank space you don’t want you need to DELETE it” 

Pressing the spacebar or the enter key INSERTS blank space into your 

document.  To the computer a press of the spacebar or the enter key means you 

have INSERTED a character – exactly the same as if you have entered a letter or  
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a number.  You can’t see it – but the computer can and knows it’s there. 

 

So to REMOVE this blank space you need to DELETE it.  Yes, DELETE it.  

You DO NOT want to “move” the text that comes after it, you want to DELETE 

the space.   

 

Apologies for all those upper case letters, but I can’t over emphasise this point. 

I’ve lost count of the number of students who ask how they can move their text.  

I usually have the rest of the class trained like performing monkeys – so when I 

ask them “what do you do with blank space you don’t want?” they answer 

“DELETE it”.  It works, honestly. 

 

“You’re a random clicker” 

Yes, folk, I’ll bet you’ve all done it.  You’ve no idea what you are doing, or 

something isn’t working as you want it.  So in your frustration you start clicking 

on every icon in sight in the hope that the computer might relent and do what 

you want it to do. 

 

It won’t.  It will do exactly what you’ve told it to do each time you click.  The 

more frustrated you get, the more randomly you click and the more actions the 

computer performs.  Result?  Chaos. 

 

So.  Don’t go there.  Don’t be a random clicker.  STOP.  Turn the computer off, 

walk away and put the kettle on (or have a stiff drink – that works too).  Please 

only use the stiff drink option if you are at home – I do not advocate drinking 

and driving.  Just so you know 😊 😊  

 
“It isn’t a competition” 

Work at your own pace.  Don’t try and learn too much at each session.  The 

more you try to learn in a session, the less you will remember. 

 

Students usually look at me with a huge sigh of relief when I tell them at the end 

of the first class that I don’t expect them to remember everything that I’ve taught 

them.  Practice makes perfect. 

 

I liken learning to use a computer to learning to drive.  No-one ever learnt to 

drive by reading a book.  It takes practice and repetition. 
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“Teaching your spouse to learn to use a computer is the short route to 

divorce” 

Seriously, don’t go there.  It’s like trying to teach your spouse to drive.  Result?  

Arguments, accusations, dirty looks and no dinner for a week.  It isn’t worth it. 

 

I’ve had married couples on my courses who sit next to each other and even 

insist on sharing a computer. 

 

I’ve had married couples who sit as far away from each other in the class as 

possible. 

 

I’ve had married couples who refuse to attend the same class and will come on 

different days. 

 

Don’t get divorced because of a computer.  They are really boring third parties 

and I don’t think you can yet cite them as the “other” woman or man in divorce 

proceedings. 
 

“If a single click/tap doesn’t work ………..” 

 

……..try a double click/tap. 

 

It’s a question I’m often asked.  “How do I know whether to single click/tap or 

double click/tap?”   It’s not hard – try a single click.  If nothing happens you 

have two choices – you can stare malevolently at the computer, or you can try 

double clicking.  The second is usually more effective. 
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Bonus Windows Topics 
 

Safely Eject 
Use this if you have plugged in an external device that uses its 

own memory – for example a memory stick, a camera (or the 

memory card from a camera), or an external hard drive. 

It’s tempting just to unplug the device when you have finished using it, but 

occasionally doing this can corrupt the device. 

So, the safest way of removing such a device is to use the “Safely 

Eject” function. 

Note – this isn’t necessary when unplugging a mouse or external 

keyboard as these don’t contain any memory of their own. 

 To do this, click or tap on the upward pointing arrow at the 

bottom right of your screen.  

 If the device that you have connected needs to be safely 

ejected, you will see the safely eject symbol – the one that 

looks like a petrol pump. 

 

 Click on this symbol and you should see the device 

that you want to eject displayed.  Like this:  

 

 Click on the name of your device. 

 

 If it is safe to remove it, you will receive 

a message telling you that it is safe to 

remove.  

 

 You CANNOT safely eject the device 

if it is still in use.  This could be 

because a document that you have 

opened from the device, or saved to 

the device, is still open.  You will 

need to find and close the app or 

window before ejecting the device.  If 

https://youtu.be/XDlBagWzy38
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you cannot find the program that is using the device, turn of the computer 

and then remove the external device. 

 

Keyboard Shortcuts 
 

As I said at the start of this course, there is always more than one way of doing 

something on a computer. 

 

Many of the things that I have shown you how to do using a mouse or touch 

screen can also be done using keyboard shortcuts.  I use a lot of these shortcuts. 

 

So here are some of the most common.  This is not a definitive list, just the 

shortcuts that I use myself.  

 

 Ctrl + X  = cut.  Hold down the Ctrl key and press x  (you will need to tell 

the computer which bit of text or which graphic to cut – refer to the section 

on Cut, Copy & Paste above) 

 Ctrl + C = copy 

 Ctrl + V = paste 

 Ctrl + S = save (the one I use most often) 

 Ctrl + P = print 

 Ctrl + + (yes Ctrl and the + key) = zooms in if on your web browser 

 Ctrl + - = zooms out on your web browser 

 Ctrl + N = start a new document 

 Ctrl + A = highlight all 

 Ctrl + Z = undo 

 Ctrl + Y = redo 
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Window Apps 
 

There are some handy apps built into Windows which you won’t 

see unless you know they are there.  Here are a few that I use 

regularly. 

 

Calculator 
I have the calculator pinned to my taskbar for quick access.  
 

This is my taskbar, and this is the calculator. 

 

 

 To find the calculator on your computer, click or 

tap in the search box at the bottom left of your 

screen and type in “calculator”.  

 

 Click or tap on the Calculator, which will open 

and look like this:  

 

 

 

 

 

 

 

 

 

 

 

 

 

 To pin it to your taskbar for easy future access, 

find the icon on your taskbar and RIGHT click 

on it or tap and hold.  (Remember, this brings up 

a menu) 

 

 Click or tap on “Pin to Taskbar”. 

 

 

  

https://youtu.be/WFS19L44NLQ
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Snipping Tool 
 

I used this handy tool for many of the screenshots that you see in this course.  

 

To find it, type “snipping tool” in the Windows search box (see instructions 

above under calculator). 

 

I’ll show you how to use this tool in the video. 

 

Notepad 
 

A convenient text document.  It doesn’t have the multitude of functions that 

Word has, but can be handy if you want to save a quick note. 

 

Also useful if you are trying to copy and paste something from the internet and 

don’t want all the formatting that goes with it.  If this sounds too advanced, 

don’t worry, but it is a very useful tool for web designers as it strips out 

unwanted formatting that Word would keep. 

 

Sticky Notes 
 

A handy way to write yourself little reminders, which will stay on your desktop.  

 

As with all the above tools, use the search box to find Sticky Notes.   

 

Once you have one sticky note, you can add more if needed 


